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   PCAD 4.5, P_CAD 2000, -

      .
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1.1   .
  .  . -

 .    .  -
  .  .

1.2     ( )  .
  .   .  -
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 , -  .
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  ,    
 .

 :
-  ;
-  ;
- .

 
  ( , , , -

)       ,    -
,      .   

     =( 1, 2,… n),
|X|=n     (  )
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      : .
mnnnp ccccccccC ,2,1,2,11,1,02,01,0 ,...,,,...,,,,...,, .

      .
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 G=(X,U) ,  X={xi} ni ,1   G, U –
 U={ui,j},    
X.

  G,    
X={xi}   (     

    ),    ,
      U={ui,j}  

  E ={ei}.
       1, -

   (  1),    G1=(X,U)
   3:

 2    1

 1       .
       -

  1  -      
 .

   1  
 2 ,     ,    ei E, -

      (  3).

 3    2

X4

X5
’

X6
’

U1
X7

’X1
X2

X3

U5

U3

U3 U5

U5
U4
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’

U1 X7
’
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’

X1 X2

X3 X4

U5 U6
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   2  -
   G=(X,U),    

      xi,
  ei  ( .   4).

 4    3

    : -
     .    -

 1, 2, 3     
.

        -
  D=(X C E,U).     -

   I=||ik ,P||,   ik,p   -
 -1,  0,  1.

ik,p = -1,   ep –   ;  ik,p = 0,  ep
    ;  ik,p = 1,  ep –   .

   ,    1,
 I :

001100
011-110
1-11100
01-01-01

I

eeeeee

4

3

2

1

654321

x
x
x
x

      -
 (e1, e2, …e6),       ( 1, 2, 3,

4).      -
   4    5.

X5

X6

X1 X2 X7

X3 X4

U1 U3

U5

U5 U3

U4

U4

U6

U3
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 5    4
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  ,        -
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 ,  ,  , . . 

  ,      
.        -

  .
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      .   

      -
.        

    ( )    -
        .

      -
 -    , 

   ,    ,
, .

3.1  

      
D=(d1,d2 ,…, dn ) n     Dk,

Nk ,1 ,        
   F(x).
  N       

  :

x1 x2 x3 x4 x5 x6

e1 e2 e3 e4 e5 e6
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                       F(x) min (1)

:21 Nlk ,...,,,

;lk DD (2)

,
1

DDU k

N

k
                                                 (3)

Dk  D –  , k-  
  ,  Dk     -

 , . .
N

1k
nnnD kkk ; .                                         (4)

       n 100 !
       -

 ,     
 .
,   n  

  N   ,    
   .

 X={xi,k}  , i,k – -
  X, ni ,1 ; Nk ,1 ;

.,0
;,1

,
ki

ki
Dd

x

  F(x)     -
 

{Dk } ., Nk 1
,   :

min)( ,,, jili
n

j

n

ji

N

k

N

kl
kj xxxF

1

1 1

1

1 1
,                        (5)

 :

nix
N

k
ki ,,, 11

1
;                                            (6)

Nnx k
n

i
ki ,,, 1k

1
;                                        (7)
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)(
,

)( k
Ski

n

i

S
i VxV

1
;                                          (8)

);(, 10kix ,                                                   (9)

ij  -    di dj;
)(S

iV  -  S  di;
)(k

SV  -   S,   
Dk ;

S -    ,   -
: ; ; ,    . .

  (5-9)   (6 , 7)  ,  
        Dk  

 Dk     , 
 nk .

3.2  

      
     .    

        
.     -

   ,  , -
 ,      . .

      -
        

 . ,     -
.

      d1, …, dn

 q1, q2,…,qm (m n)   ,  -
         -

.
  :

.,0

;,1
,

ki
ki

qd
x

       -
:
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min)( ,,,

1

1 1 1 1
, jisksj

n

i

n

ij

m

k

m

s
ki plxxxF                  (10)

 :

nix
m

k
ki ,,, 11

1
;                                            (11)

n

i
ki mkx

1
11 ,,,                                            (12)

xi,k=(1;0), (13)

lk,s–   qk qs; i,j –    -
di; dj.

 (11, 12)        ,   -
           -

        .

3.3   
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  –         -
   .    -

   -       -
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ji xlxF

k k1

1 1
(14)
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(16)),1;0(

(15);,1,0

n

1j

k

i,j
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x

niKx
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 (15) ,          -

    K0 .
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  (17,18)     :
kn

r
jijijr

S
ri

S
ji xxyy

1

11   y ,
)(

,,
)(

,
)(

, ; ; (17)
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  .     
     , ,

   .   -
         -

   .
      -

      ,  
  .    

           -
   .

  ,    , 
        ,    -
.        

   .     -
     .   
      .

          -
.       (  )  

,    .    -
            -

    .
       -

  .   -
     ,  

  ,       
 .      -

    .    
       -
      (  -

 19 - 21).        
        

      (  
22 - 26).

min)( j
Jj

j xcxL                                        (19)

  ( ):

mibxa ij
Jj

ji ,1,,
;                                      (20)

jxx jj -,0 ,                              (21)
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ai,j –  i-  ,    j-  ;
j -   j-  ,     -
  ;
j –  j-  .

min)( ,
1

jij
Jj

k

i
xxL                                (22)

    ( ):

mibxa ij
Jj

ji ,1,,
;                                  (23)

,-,0 jxx jj                                 (24)

: ai,j –  i-  ,   j-  -
;

j -   j-  ,    -
 ;

i,j –     j   
 i-  ;

bi –  i-  ,    -
 ;

 –        -
  –      

   -    .
       -

 .
  -   «  ».

min)(
, j

IiJj
i

xxL                                 (25)

   ( ):

m1,i,1, ji
Jj

x ;                                      (26)

Jkxn jij

m

i
i j,

1
;                            (27)

  xi,j= {0;1},                                                  (28)
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xi,j  -  ; xi,j  = 1,    j-  -
 i-   ; xi,j  = 0,    j    i-

  .
kj  -  ,    j-  ;
ni -   i-  ,    j-  .

 (26)  ,    
       

.
 (27)  ,    , -

  j-       , -
  .

      
  .   ,   

     
,     ,    .

    «   ».
 «  »    

      
         -

 .     , -
,   . ., . .  1-  .     -

        -
   .     

 -    .
      

     = { 1, 2,…, n },  -
       .

   ,   1, 2,…, n,  
   t(xi), t {1,...,l}.     

 M={m1,m2,…,mt,…,ml},   mt –  -
   t.      

R = rv,t , v {1..k}, t {1..n}, rv,t    t  v.
      ,   
  ,      .
  cv    .   -

   c F: v

n

t
v RcF

1
.

     , 
   .

1.        ,  -
  ;       

 .
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2.    ,    -
;         .

3.     1,    
 .
4.     2,    
 .

 ,    2.  -
       :

min
1

v

n

t
vcF (29)

 :

;
1

,
1

,, t
v

ta

l

a
atv

Vv
tv mSSr (30)

;0v (31)

,-0,atS                                     (32)

mt  -   t,   ;
St,a –    «t»,    

  «a»;
S ,t –    «a»,    

  «t»;
v -   v ,    .

 (29-32)      -
.     .    -

     . 
     .  -

      .  -
  « 155L 3»    8.     

  ,   « - »   .
  ,       2, . . 

      .
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    ,     -
        .   -
      -

.      : 1)  -
      ; 2) -

    .   R  = rv,t ,
v {1..k}, t {1..n},        M0 =  mt .

     .
1.      { v}    :

1;  2;  3;…  ; v    (  1 2 … k ... Cv ).  k  -
   k.     
i=0.      

  0,       -
,   .

2.  « - »  k   -

 i = i+1: )(i
kA =min {mt /rk,t}, r k,t –    «t» 

  «k».
3.    «  » i:

k
i

kii RAMM )(
1 .

4.   Mi >0,   .2, M i= 0,   .5.

+55
V

3

2

4

5

6

1

7

& OUT
INA

INB

&

&

OUT

13

12

11

8

&

OUT

9

10

 8
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5.      : v =
p

1i

(i)
vA ,  –

    ; v = {1,2,3,…,k,…,v}.

 .    (  9),  -
  (  10) .

.

 9

 10

111

11

111

1 1

3 6

2 5 10

4 9

1 12 8

1

1

11

13

7

1 1

t1 t2
1

1

t4

t3

1

1
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   t1,  t2,  t3,  t4     
1, 2, 3 (  11):

t2
t1
t1

1

t2
t3

2

t1
t4

3

 11

 Rv     :

t1 t2 t3 t4

Rv =
1001
0110
0012

   Rv      – 1,
2, 3.  –   : t1, t2, t3, t4

        1.

 1
  t1 t2 t3 t4 t5

 -
 -

  
5 4 1 1 0

    ,    -
  :

min332211 xcxcxcL                                     (33)

 :

xx 52 31 ;                                            (32)
421 xx ;                                                      (33)

12x ;                                                             (34)
x 13 ;                                                             (35)

-0 jj xx , ,                                         (36)

: xj –  j-  ,    .
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     .
1.     1  0 = (5,4,1,1) .
2.      { v}   

:
1; 2; 3 ( 1 2 C3 ).

3.   1,  . .    .
  « - » )(A 1

1  
1..   1      t1, t2 ( .

Rv).
      t1     1

1,1= (5 div 2 = 2);
       t2     

1 1,2= (4 div 1= 4).
  )(1

1A =min { 1,1,  1,2 ); )(A 1
1 =2. ,

| 1|=2 .
   : i= i+1, i=0+1, i=1.

4.     «  » i , i – 
  (i=1).

11
1
101 ,rAMM ;  1= (1,2,1,1).

5.   1  0,     ( i =2 )  
2.        -

 ,     i .

6.
1
2

min
3,2

2,22
2 A

A
A ; 12

2A ; 2 = 1; M2=(1,1,0,1).

  M2>0, -  3-  .

7.     3.

1
1
1

min 3
43

133
3    ;

A
A

A
,

, .

3=(0,1,0,0).
  M3>0, -  4-  .

8.   3      – m2 . -
         t2,
    1 2.

  1<C2    1.
9.  4:  4=(0,0,0,0).

  4 = 0,   .  
    ,    -

.
  1 = 3, 2 = 1, 3 = 1.
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   ,   –    -
 ,       -

      ,    
 1     t1.

    G=(X,U), X –
 ,    , 
  U – .
     -

      ( ).
         'G .  

    , 
  .     

  G     {G '
1 ,G '

2 , …,G '
p }.  

     .   -
 G  Si,p, i –  ; p –   -

 .
       -

  gi,k.
1,  ui,    ;

gi,k=
0,   .

 ,  ,   .
      ,  :

min
2
1 n

i

n

k
ikgg .

  .  –   -
        -

.   ,    -
    .     -

        -
 ( . . ).       -
   :  (G)  

G     ,  -
 :

1)    Gi,Gk,    -
,   ;

2)        ;
3)        

 (  ,     
  );
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4)        
  (  ,   

      ).
     

   ,    .
         -

     :
1)       

;
2)          -

;
3)        

         
.

4.2     
(  )

   , , -
. -       –  -

      ,  -
.

   :
1)   ( , , );
2)    ;
3)    G=(X,U).

      ( -
)    s, t,       Gr,.
         -

G=(X,U)   Gr,  ,  
       

ji
ji

ji rdGL ,
,

,)(
2
1     

Uu
ji

i

PGP )()( ,u
2
1

       
   .    ri,j  

   xi; xj ,  P(ui,j) -    -
 ui,j      , di,j   

,    xi; xj .
di,j   ,    

xi; xj   - dij=|si - sj|+|ti - tj|.
    Gr   -

D.
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.,
;,0

;
jij

ji
ijij xxid

xx
ddD

       
      -

.       : -
  .     , -

   .    
, , ,   ,

      .
    

       -
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    .     -
    .

      -
   .     -
        . 

       -
   ,     -

 ,       -
 .     -
  .     .  -

       -
     ,   -

.        -
      .   -

.     ,    -
        .

 ,      , -
  .       
    ,    

 .    
.    ,   -

       -
.     ,       

        -
.
        -

    .
-  

        -
.  ,           -
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       , 
     .

       
G=(X,U),    , 

   ,      
Gr.    ,      -

 .        
 .   xi X  G     -

Gr     uj  U.       
Gr      G. ,   -

 Gr       .

  
 xi  X  (j+1)-  , j –  -

 ,    (xi)  -
: zihii aax ,,)( , ai,h –  , xi-   

 ; hiizi axpa ,, )( , . .  , xi 
  , )( ix -  ,  -

xi (  xi).  )()( , ihii xpax 2 , ai,h 
, xi     . )( ix

       xi c max
)( ix .  xi       (  

Gr) .      -       
.        ,   

   G.

   (    -
)

      
  .

   « » v-    
 xj      – Lj.

jirrdL
n

i
jiji

n

i
jij

11
,,,, / , di,,j –   

,    xi     j-  ;
ri,j –   xj      j –  

 G; Lj  -   ,   xj, 
 v.

 , ]L))[( dUu( ji,jji,j 11 , Uj  - 
,  xj ,   v .
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     ,    -
    .

   ,   , 
xj ,

 Lj       

   ji
ji

ji rdGL ,
,

,)(
2
1 .  ,   -

     .
  ,   xj  -

  ,      
         xj,
        )(GL .

   (sc tc)   -
   :

jn

j
ijijc

n

j
ijijc

x
xrtt

xrSS
" "

1

1

)(/

)(/

,

,

,

ri,j –    x       -
 {xi}; xi –     Lj ;

(xi) –  xi .
        

 :

N

i

N

j
jiji rdL ,,2

1 .

       -
       , -

   .    
      ,  -

      .

     -
     -

      .

1.      
    s, t, . .  Gr.
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2.      G,
   Gr.

3.    G   
Lj.

4.  xi  max Lj.
5.   xi     sc t .
6.    X’ ,   -

     xi .
    X’  

xi     'Xx j ,      xi -
v
jL  v

iL      ( v
jL  -   

j-  ,    v).
7.   XxLL jj

v
j

v
j

-k    -

,     . .4,6 , v k  « -
»  « »   .

8.   a
j

v
iij   

X’  xi .    ,    -
ij .

9.    .

   

 G=(X,U).    R=||ri,j|| 9×9   -
  :

r1,4 =3    r4,1 =3     r2,3 =2     r4,2 =1
r1,7 =2    r7,1 =2     r2,4 =1     r3,5 =2
r1,8 =3    r8,1 =3     r3,2 =2     r5,3 =2
r4,6 =5    r6,7 =5     r7,9 =2     r7,8 =3
r6,4 =5    r7,6 =5     r9,7 =2     r8,7 =3
r5,6 =2    r6,8 =6    r5,9 =4
r6,5 =2    r8,6 =6    r9,5 =4

 ri,j   R   ,  i-
  j-    G.

      
  ,      -

.
 1.     - Gr   9 –

   (S T). ,    1  -
 (0,0).
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 2.   G   Gr  ,  -
         .  -
   ,       (

11 ).

 3. Lj   xj ..  di,j – -
  :

.,

;

11
jirrdL

ttSSd
n

i
ijij

n

i
ijj

jijiij

X4 X5
X6

X8X7 X9

X3X2X1

1 2 3

4 5 6

7 9

Gr

T

1 2 3

4 5 6

7 8 9

t

S

 11
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.28/168/493
233/2)21100110(3)11102110(

3)11100110(/
23

1
1817141717181814141 rrrdrrdrdL

 :

L2 1,3;  L3 1,5;  L4 1,7;  L5 1,7;  L6 2,2;  L7 2,2;  L8=2;  L9=2.

x6,       :
Lj=L6=2,2.

 4.     tc , sc  x6,
       Lj:

n

j
jjijc

n

j
jjijc

xrSs

xrtt

1
,

1
,

)(

)(
                                            (*)

    (*)   , 
x6. x4; x5;  x7;  x8,  . . j={4; 5; 7; 8}.

.4,018/8)6525/()61502150(

;4,118/29)6525/()62522151(
6

6

c

c

s

t

 5.    (Sc
6  tc

6)  
,      x6.   -

,     1 (   4), - x4 , x5 , x7, x8 ,    
 x6.

 6.   L5
6 , L4

6,  L8
6 , L7

6   x4
x5  x7 x8,         x6, . .  

 6,  L6
4, L6

5 , L6
7,  L6

8  x6,      -
 x4 , x5 , x7 ,x8 .

 L4
6:

3,2
9
21

135
123352

424146

4262416146646
4 rrr

rdrdrdL .

  : L5
6 1; L7

6 2,4; L8
6 2,5.
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 L6
4:

6,1
68676546

68486747654546464
6 rrrr

rdrdrdrdL .

  :

L6
4 1,6;  L6

5 1,3;  L6
7 1,7;  L6

8 1,6.

 7.    j
V    x6 x5; x4;

x7; x8 .

   x6:

;6,06,12,2

;5,07,12,2

;9,03,12,2

;6,06,12,2

8
66

8
6

7
66

7
6

5
66

5
6

4
66

4
6

LL

LL

LL

LL

   x4 ; x5 ; x7 ; x8

.5,05,22

;2,04,22,2

;7,017,1

;6,03,27,1

6
88

6
8

6
77

6
7

6
55

6
5

6
44

6
4

LL

LL

LL

LL

 8.  a
j

v
iij    x6 x5; x4;

x7 ; x8 .

.1,0)5,0(6,0

;3,0)2,0(5,0

;6,17,09,0

;0)6,0(6,0

6
8

8
66,8

6
7

7
66,7

6
5

5
66,5

6
4

4
66,4

    i,j .
 i,j= 5,6   -

x6 x5 . ,   x6 x5 .
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      . -
   ,   ,  -

     3-8.
   (  11 )  -

 L(G)=55.  ,     
L(G)=76   L(G)=55.

 ,      , 
 L(G),    ,  -

  ,  ,      
.     Gr     -

 G .
  ,    12,  -

G .   13-14.

T

X1 X6
X5

X8X7 X9

X3X2X4

1 2 3

4 5 6

7 98

T

X1 X2 X3

X4 X5 X6

X7 X8 X9

Gr

 11
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                        13                                         14

 « »  ,   -
 14,       12. 

,    15,   
        .

 15

      -
LG    (5-7)%.

4.3    

    ,  
,       -

        -
.

1

2

3

2

3

1

X4 X6

X1 X3

X5

X2

X7 X8 X9
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     , -
    ,    -

     ( ).
      

   .

      

 –       ,
     .

      -
     ,   -

       -
.

   :
1)      -
 ,    ,    -

   ;
2)       ,  -

     ;
3) ,  ,   -

 .
      -

 ,        ( -
 )  ,     -

 .     
,     .

 –      -
      .  -
     .

  –   -
    ,    -

  .
     -

, . . .

 :
- –       
;
- –   ;
- –    -

 ;
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- –      
 ( ).

       :
 ,  , -

, , ,      
   ;

     :
-        

;
-   ;
-     ;
-     ;

   (    -
  ).  :

-    ,   
    .

     .
 –     ( -

,  , , ,   . .), 
   . (    45-60%
 .      , ,  -

).      .
     -

,      
    ,    

.       
PCAD       -

 .        
;       -

    ;  -
  ;   

        -
 .

 ,  ,  
    ,    :
  ,   , ,

,  ,  .
    –  

        -
 ( ,      ) 

      .
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      .
      .
     
   .
    .

    -
    .

 /     -
 (    –     )

     .
        -

  .   ,
         – « -

»,   « / ». -
  PCAD 4.5 -       -

      . 
   :    ;

       
  ;    -

        .



40

5    
    PCAD 4.5

5.1     PCAD 4.5

      MS DOS
     PCSHELL. PCSHELL – 

 .
     MS-DOS    -

   [Enter].        -
     ,   -

  PCAD         -
     .

     :
>PCNODES TEST [ENTER],

     «  », . . «PCNODES» -
,      TEST.SCH;    TEST.NLT.

         
    .

 PCAD: PCCAPS, .. RDS, PC-PLACE; PCPRINT; …
PLOTS; PC-PACK –    ,    -

 .
:

>PCCAPS h – .
- h –        -

.
- r –     .

   PCAD     PC-SHELL.
 :

  PCAD <Enter>     , 
 :

-    ;

,
 PC ROUTE
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-     .
D* -     .
P* -     .
C* -     .
S* - .
I* -  .
U* -  .

: -   .
S: -    .
N: -   .
L: -   .
R: -  .
P* -     .
K: -  FIL – .
P: - .
B: -    .

 :
«*» –    (   );
«:» –   .

     : ,
[D]  [S]      PCCAPS.

    «/»:
/DS – PC CAPS;
/DN – PC NODES;
/PR – PC ROUTE;
/PL – PC CARDS;
/PP – PC PLACE

 . . (   17).
   PC SHELL      /r, . .

  .
      [F7]+  +[Enter].

5.2.     
 

      
  ( ).

 .     -
 ,        

 .      PC-
CARDS.      PCCARDS,  
        -

   *PRT/.
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   .    -

 PC-ROUTE.

 .      -
    .    -
          ,    

      -
  PCAD,      .   

          *.ALT,  -
   PC-NLT,     

*.PKG         PC-PLACE    
        -

 PC-ROUTE.

*.ALT –   .
*.PRT –       -
  (  *.PRT).

*.PRT P
C

P
C

*.PLC

*.PCB

 DRAW 
 SLKSCR 

BORDER

 

P
C

*.ALT
*.PRT

PC-PLACE
*.PKG

PC-ROUTE

*.PLC

*.PCB
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 .      
      PC-

CAPS.         -
        ,  -

    , 
       -

.      
.         -

   ,   
,         -

 .

     PCAD (  ).

    -  PC-
CAPS,  DETL.  –  *.SCH.

      
 PCNODES.

   ,  
 :

-       -
*.FIL;

P
C

*.NLT
*.PRT

(PC-CARDS)

PC-PLACE
*.PKG

PC-ROUTE

*.PLC

*.PCB

P
C

P
C

*.SCH

*.FIL

 -

*.SYM (SLB)
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-  PREPACK    .FIL  -
    .LIB.

   ,   -
 PDK PCCARDS,  DETL.  –   

.PCB.
       -

  .   PCPACK.  –
   .PKG    PCPACK.ERR,  

   .
        -

 –  PCPLACE.
   – PCROUTE.   – -

  .PCB (    +   +
 ).  .REP –      

.
  .PCB    .PLT,   

       
PCCARDS,  DETL\SYS\PLOT.

     (.PLT)
  PC-PRINT  PC-PLOT.

    ( )
   PCAD,    ,  -

    :
1. C     ( ) -

     
 (  PC-CAPS).

2. C    -
 (  PC-CARDS).

3.     (  PC-
CAPS).

4.       
(  PC-NODES).

5.     
(  PREPACK).

6.    (  PC-CARDS).
7.      

(  PC-PACK).
8.     -

      (  PC-PLA-CE).
9.     (

PC-ROUT).
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10.      -
       .

       -
         -

.
       

  ,     -
 .

5.3      

       
   , . .     

    .     -
       .   

   4-   -    
  .       -
  4  (  2).

 2
  

        
       

 1 K155 1 4 4 1 1
 1 K155 1 3 3 1 1
 1 K155  3 2 2 1 1
 1 K155  1 2 2 1

     ,   -
       . 

        -
 PC - CARDS.

    pccards    Enter ,
      PC - SHELL, -

         P
 L.

    .    -
  PC - CARDS   Configure PC-CARDS (

  PC-CARDS)  .    -
      «  »,

«  »   Space bar.   
   Enter.

       - , -
       ,  -
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     ,  -
     .  

    Libary filename (  ).
    ,   -

     155   -
  .      -

 prt      PRT  plb -   PLB.
   plb      -

    *.prt.     -
   -  PC - LIB.

   :
*.PRT -    PRT,    

C\PCAD\PLB\155.plb  *.plb,    C:\PCAD\PLB.
     

Esc.       . -
 YES    Enter.    -

   pccards.cfg,   .
       Edit

database   .
        
        -

 Space bar    .
      50 : 50.  -

/      -
 F7.

   VLYR  :
SLKSCR -      
;
BRDOUT -   ;
DEVICE -    ;
PIN -     ;
COMP - 1 -   ;
SOLDER - 2 -   ;
ATTR -  ;
$CONT -  ;

     
ABL, ,  BRDOUT  , . .    -

 ABL A.      (Off). 
Quit     .

     ,  
  SOLDER,   DRAW/LINE  DRAW/RECT -

      , -
    .



47

      BRDOUT 
 DRAW/LINE  DRAW/RECT   

,     .  -
,        , 

    .   -
      ( W=0 ), -

      .    -
        ,

         
.   ,     .

       
 ENTR/COMP.        -

      , 
  ,    F1   

    ,     
  .

       ,  
 ,   PgUp ( )  PgDn ( ).  

         -
  .    

PLB    .    
  PRT- .

      :
New layers may be added. Continue? Yes No
(   ?  )

 Yes    Space bar    -
.

  :
Converting comp to the English Unit. Continue? Yes No
(     ?  )

 Yes    Space bar    -
.

 ,      -
  , . .   -

 « »        
.          

       .
     Space bar  
 .

 ,      
    :
1)   ENTR/COMP;
2)      F1;



48

3)      155LN1   -
  ;

4)          
 ;

5)         -
;

6)   3 - 5     -
  ;

7)     adapters.plb      r2hn-
15.prt,     , 

           .
      Exit List (   -

)     .
 ,       -

 .      -
,  :

CLYR -   ;
MOVE -     ;
ROT -    90 .    

    ,     
 ;

DEL  -  ;
COPY -   .

        -
.      WIN, 

     . 
       

  .       
      

   . ,  ,   
      .  

  5    2 :   « 
«,      ,  -

 .
   ,     

  ,    
.  ,      

    ,    , -
  MOVE.

        
   .      -

  ENTR/RATN.     
,       . 
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,   ,    
     .     -

          -
 .        , 
    1        

  ( . 16).     -
   1-  .

14                 8              14                     8
----------------- -----------------
| .  155 1  |            |>   155 3 |
----------------- -----------------
1                    7               1                    7

 16

   155   -
:

7 «  «
14 + 5V

        -
    .  155 1

 6   ,  ,   
  4   .     -

       .
    :

1)   ENTR/RATN;
2)     1-   

155LN1;
3)    5-    K155LE1;
4)        
  ;
5)        . 

  ,         -
.       R,  

  , . .   R  (R , 
  );
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6)   ,   .  -
  «  «   .   

     .
 PCAD  ,    

      , . .  -
       , 

     .
    REDR - 

.
       FILE/SAVE. 

      (auto1.plc)  
 Enter.     ,    

 .
       SYS/QUIT,

   -    Exit PC-CARDS  .
      

, . .     .  
   PCAD   PC - ROUTE.  PC -

ROUTE      -
     .  -

       -
       .

    PC - ROUTE   -
,        -
      .    

auto1.plc.
     , 

     .    -
  .     CTL.

   PC - ROUTE  
:

-   ,     -
   ,   PCB;

-  ,   , 
 REP.

        
*.RTS, *.RTE.         -

 .  ,    
 (     )   -

    PC - CARDS. PC - ROUTE
 ,  .    -

   :
-  -   $CONT   *.PCB;
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-  -    *.REP.
       pcroute  -

  Enter ,      PC - SHELL, 
       P  R.

   PC - ROUTE    
  .     .  -

 :
Enter database name: -  .
(Database reference name) -   , .

      PC - ROUTE.
   HOME       

 auto1.plc.
Select routing strategy -   . 

        
Space bar.

      
,  ,     -

 .  ,     -
       ,  -
      (MILS -  ;

MM -  ).      
 PC - CARDS   SCMP/UNIT.
        , 

      
.

      
:

EDIT ROUTING STRATEGY -   -
;

ROUTE -  ;
EXIT PC-ROUTE -   DOS.

 1-      :
ROUTING GRID X : 50  Y : 50 -     X, Y.
NUMBER OF ROUTING LAYERS: 2 -   
; ROUTE TYPE: STEINER - MINVIA -   .

 STEINER - MINVIA    -
 .

ROUTE ORDER: LONG - SHORT -    -
     .    -

    Space bar.    LONG -
SHORT       ,    
SHORT - LONG -     .    SHORT -
LONG     ,     -
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   ,     
LONG - SHORT.

PERFORM VIA MINIMIZATION: YES -   -
   .

ORIENTATION PREDOMINANT COMPONENT: VERTICAL - -
    ( ).   -

     .
PIN TYPE: 24 -   ( ).

 0     ,  1
 24 -   ,  25  50 -   , 

51  100 -        101 
255 -    .

        -
  PC -ROUTE,    Esc.  -

      :
Save under current name -   

   ;
Save under new name -    -

   ;
Do not use or save -     -
   .

      Space bar. -
 2-      PLATA.

  Select routing strategy    
PLATA.CTL    Enter.

       -
.       HOME 

END.
     ROUTE 

.
     ,   -

     :
EXTRACT DATA - ,   -
    .    :
YES -        

    ;
NO -       .   -
     Space bar.
ROUTE - ,   :  -

,   ( ),   .  
 :

NEW -     ;
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RESTART -        
;

NO -       -
       *.PCB.  -
      Space bar.
CREATE ROUTED DATABASE - ,  -

     (  *.PCB)  
.    :

YES -      
  ;

NO -        .
       Space bar.

DATABASE NAME - ,    
.

      
  (auto1.pcb),   Enter.   
    .

     -
   START     Enter.

      
.     :

ROUTE COMPLETE (CR)
     .
    ,   

     (auto1.rep).
      

:
DATABASE -   ;
STRATEGY -    ;
TOTAL LAYERS -    ;
NAMBER OF PASSES -   ;
TOTAL SUBNETS -    ;
ELAPSED -    ;
ROUTED SUBS -    ;
% COMPLETED -       ;
ROUTE LAYERS -   ,   
;
ALGORITHM -      ;
CURRENT SUBNET -   ,  -

   ;
KEYBOARD STATUS -   .

 Esc  ,  «+»   
 .
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6  P-CAD 2000 [ACCEL EDA 15.0]

    P-CAD  4.5,6,8   -
    .    
     DOS.  P-CAD 

Windows   1996        
 ACCEL EDA  12.   ACCEL EDA 15.0  

   1999     P-CAD 2000.   -
    ACCEL EDA  P-CAD.    -

     ,    , 
 , ,  /  
 ,         -
.

       32-   -
         

.    P-CAD      -
   :

       
Windows        .

      -
 ( , ),      Windows.

       
  - .

      
     .

        -
  .

   ,
    ,  -

  .
     -

      AutoCAD, OrCAD,
Pspise  P- AD   .

ACCEL EDA     
ACCEL Library Manager -  , ACCEL Schematic - -

 , ACCEL PCB -  , ACCEL Autorouters - -
,    .

  P-CAD 2000

    Setup  -
P-CAD\Setup.
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        , 
     ,  

.       Next,  -
Yes.          ,  

   ,   Product Type   -
 .       

,   X5YB-2SVT-X8VG-7CW8     
 Next.      

   P-CAD 2000,    
C:\Program Files\P-CAD 2000.     

Next,        :
Typical –    (  ), Custom  -

      P-CAD  
(    ). Typical  -

Next.          -
 , P-CAD 2000  Next.  Next  

     ,    -
 .     Finish,  

 ,      .
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   ACCEL Schematic
  ACCEL Schematic ( Schematic)

    ACCEL EDA.

1      Schematic
  Schematic   

Schematic  PCAD 2000,      
 « ».

       -
 .
      , 

     ALT    
   .

  ,     -
    «>».

   

 File   , ,  
 .     .  Edit -
    ,   

. View –     -
,  – ,     .  
Place        -
,    , , , . Rewire -  

   Manual   
  . Options -  ,   -

  ,     
       , 

,   ,    -
 ,   .   Library   -

      ,  -
 ,   ,  . Utils
      . -

Macro -     ,     
 .   Window   

  :   ,    ,
     .   Help

      .
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   .    

  ,      -
.
 ,    -  ,    -

 ,   .     :
 X Y -   ,   

    ,     .
  : REL -   

       , ABS - -
         .

 .
  .
  .
 .

 .

 

       -
     
Schematic.

  Options>Configure     –
    4, 3…     -
  .  Title Sheets    -

  ( ).       -
       TTL. 

   TITLES ACCEL.   -
    Display Title Sheets.   
  mil –  (1  – 0,001 ), mm -  -

, inch –  (1  – 25,4 ).    
      .       -

.
 Options>Grids   .  Add

  .
 Options>Display    , 

     .
Options>Text Style  ,    . 

      .
 ACCEL Schematic   

SCH.INI,          -



58

.    (  ,    .) 
  .

   

       -
    .    

Library>Setup      .
Add        -

.
      

Place>Part.  ,       ,
   .  Library  -

,   .     -
 ,      

,  Browse.       -
  : Normal – , DeMorgan – -
  , IEEE –     

  .      -
   –    -

.       -
         . 

        ,   -
  , ,  R,  -

  – F.        -
   .  Edit>Select
        

     ,    
 .

      -
    Plase>Wire.   

 ,       
 ,       .

     
Options>Current Wire.     

 ,     -
 .    ,  -
 ,   ,  -

.        
   Rewire>Manual.

     ,  
  -  .    -
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  ,      
        .

    Place>Bus.  
        ,  

    .   
Place>Wire  ,      .

          
     –      

 .         45
    .    

  Place>Port,     
 – .      , 

   .      -
     ,   -

 .
    P-CAD  -

  .    
:

 –       , -
 .     .

      -
P-CAD.    Title.

     :
 File>Open    TTL.
 Options>Configure –  Title

  ,      -
 Display Border.

     File>Design Info.
   ,     

.      
Options>Sheets/Add ,   .      

 ,        . 
 P-CAD ,   ,     -

    ,     ;   
         .
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    1

  ( )

   ,   
  .

 ,   .
   .

 

 1

   :

t1 t2 t3 t4 t5 t6 t7 t8

M
=

2 12 9 13 8 5 3 21

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 1 2 6
2 4 4
3 1 2 1 13
4 1 2 2 19
5 2 1 7
6 1 2 1 6

 tj –   ;
      Yi –   ( );
      i –   [   ].

 2

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 21 3 5 8 13 9 12 2

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 1 2 5
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2 4 7
3 2 1 1 1 19
4 2 1 2 13
5 2 1 4
6 1 2 1 6

 tj –   ;
      Yi –   ( );
      i –   [   ].

 3

   :

t1 t2 t3 t4 t5 t6 t7 t8

M
=

22 25 3 12 9 8 13 5

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 1 2 18
2 4 19
3 2 1 1 61
4 2 1 2 5
5 2 3 1 7
6 1 2 1 8

 tj –   ;
      Yi –   ( );
      i –   [   ].

 4

   :

t1 t2 t3 t4 t5 t6 t7 t8

M= 17 - 19 25 18 16 31 4

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 4 10
2 2 1 1 9
3 1 2 2 7
4 3 1 15
5 2 2 17
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6 1 1 1 1 18

 tj –   ;
      Yi –   ( );
      i –   [   ].

 5

   :

t1 t2 t3 t4 t5 t6 t7 t8

M= 17 21 18 13 19 22 25 4

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 4 9
2 1 2 1 5
3 1 4 14
4 2 2 13
5 1 3 19
6 2 2 6

 tj –   ;
      Yi –   ( );
      i –   [   ].

 6

   :

t1 t2 t3 t4 t5 t6 t7 t8

M= 14 12 18 - 16 - 9 5

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 4 9
2 1 2 1 6
3 2 2 17
4 3 1 14
5 1 3 15
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6 1 3 8

 tj –   ;
      Yi –   ( );
      i –   [   ].

 7

   :
t1 t2 t3 t4 t5 t6 t7 t8

M= 6 51 5 4 13 21 6 15

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 4 7
2 1 2 6
3 2 2 19
4 3 1 13
5 1 2 8
6 1 4 9

 tj –   ;
      Yi –   ( );
      i –   [   ].

 8

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 19 18 9 - 11 - 51 6

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 2 1 7
2 1 2 15
3 2 2 10
4 3 2 19
5 3 2 7
6 4 6

 tj –   ;
      Yi –   ( );
      i –   [   ].

 9
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   :

t1 t2 t3 t4 t5 t6 t7 t8
M= - - 41 15 6 8 19 11

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 2 16
2 2 1 15
3 2 2 18
4 3 1 9
5 3 1 11
6 4 5
 tj –   ;

      Yi –   ( );
      i –   [   ].

 10

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 17 13 - 6 18 19 4 0

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 2 13
2 1 1 7
3 2 1 21
4 3 1 18
5 3 1 9
6 4 10

 tj –   ;
      Yi –   ( );
      i –   [   ].

 11

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 4 22 13 - 7 14 10 9

      :
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     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 2 10
2 1 1 9
3 1 2 16
4 1 3 7
5 1 3 6
6 4 5
 tj –   ;

      Yi –   ( );
      i –   [   ].

 12

   :

t1 t2 t3 t4 t5 t6 t7 t8

M= 20 0 11 6 8 19 0 25

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 2 9
2 1 1 10
3 1 2 15
4 1 3 6
5 4 5
6 1 3 7

 tj –   ;
      Yi –   ( );
      i –   [   ].

 13

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 4 13 8 12 11 21 9 12

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 2 8
2 1 1 10
3 1 2 6
4 1 3 15
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5 4 5
6 1 3 6
 tj –   ;

      Yi –   ( );
      i –   [   ].

 14

   :

t1 t2 t3 t4 t5 t6 t7 t8

M= - 6 12 4 8 5 13 -

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 2 13
2 1 1 5
3 1 2 7
4 1 3 9
5 4 6
6 1 3 19

 tj –   ;
      Yi –   ( );
      i –   [   ].

 15

   :

t1 t2 t3 t4 t5 t6 t7 t8

M= 13 9 - 7 18 11 - 4

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 2 19
2 1 1 6
3 1 2 9
4 1 3 7
5 4 5
6 1 3 13
 tj –   ;

      Yi –   ( );
      i –   [   ].

 16
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   :

t1 t2 t3 t4 t5 t6 t7 t8

M= 1 13 6 9 5 12 16 13

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 4 32
2 2 1 1 24
3 2 1 9
4 4 18
5 1 2 1 13
6 4 1 11

 tj –   ;
      Yi –   ( );
      i –   [   ].

 17

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 6 14 8 - 16 21 22 2

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 4 19
2 2 1 7
3 2 1 10
4 4 6
5 1 2 1 18
6 1 4 5
 tj –   ;

      Yi –   ( );
      i –   [   ].

 18

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 13 17 15 6 9 2 14 6

      :
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     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 4 9
2 2 1 20
3 2 1 6
4 4 7
5 1 1 14
6 4 5

 tj –   ;
      Yi –   ( );
      i –   [   ].

 19

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 6 14 2 9 6 15 17 13

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 2 1 5
2 4 20
3 2 2 14
4 1 1 1 1 6
5 1 2 3 7
6 2 2 14
 tj –   ;

      Yi –   ( );
      i –   [   ].

 20

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 14 9 17 13 15 6 2 18

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 2 1 7
2 4 6
3 2 2 20
4 1 1 1 1 25
5 1 2 3 5
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6 2 2 14

 tj –   ;
      Yi –   ( );
      i –   [   ].

 21

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 25 5 0 18 19 22 32 17

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 4 12
2 2 2 8
3 1 2 1 7
4 2 2 11
5 2 1 1 9
6 1 1 1 1 6
 tj –   ;

      Yi –   ( );
      i –   [   ].

 22

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 22 34 11 2 5 17 21 19

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 2 1 1 5
2 1 1 2 6
3 1 1 1 1 7
4 1 1 1 1 4
5 4 5
6 2 2 7

 tj –   ;
      Yi –   ( );
      i –   [   ].

 23
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   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 21 19 22 15 14 32 54 48

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 2 1 1 9
2 1 3 6
3 2 2 8
4 1 1 1 1 7
5 1 1 2 7
6 2 2 5
 tj –   ;

      Yi –   ( );
      i –   [   ].

 24

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 56 43 25 32 22 17 0 19

      :

     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 1 1 1 3
2 1 1 2 4
3 2 1 1 5
4 2 2 2
5 1 1 1 1 4
6 3 1 6

 tj –   ;
      Yi –   ( );
      i –   [   ].

 25

   :

t1 t2 t3 t4 t5 t6 t7 t8
M= 43 32 21 20 15 18 33 27

      :
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     tj
Yi

1 2 3 4 5 6 7 8 Ci

1 1 3 7
2 1 1 1 1 8
3 1 2 1 5
4 2 1 1 6
5 1 3 9
6 2 2 4
 tj –   ;

      Yi –   ( );
      i –   [   ].

  2

  2    .

 1
  .    -
 .

 :
   G=(X,U),  U= ,

kji xx ,   “ ”   -
 ,   xi , xj .

 1
U= 221xx , 132xx , 182xx , 151xx , 141xx , 373xx , 164xx , 186xx , 397 xx , 185xx ,

254xx

 2
U= 221xx , 332xx , 182xx , 551xx , 141xx , 373xx , 164xx , 286xx , 397 xx , 185xx ,

254xx

 3
U= 421xx , 332xx , 682xx , 251xx , 141xx , 373xx , 164xx , 186xx , 397 xx , 185xx ,

254xx

 4
U= 221xx , 132xx , 182xx , 151xx , 141xx , 373xx , 164xx , 486xx , 197 xx , 585xx ,

754xx

 5
U= 221xx , 132xx , 782xx , 151xx , 541xx , 373xx , 164xx , 186xx , 397 xx , 185xx ,

254xx
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 6
U= 221xx , 132xx , 182xx , 151xx , 341xx , 373xx , 164xx , 486xx , 697 xx , 185xx ,

254xx

 7
U= 221xx , 132xx , 182xx , 151xx , 341xx , 373xx , 864xx , 986xx , 397 xx , 185xx ,

254xx
 8

U= 221xx , 132xx , 182xx , 151xx , 141xx , 373xx , 364xx , 586xx , 397 xx , 785xx ,

254xx

 9
U= 221xx , 132xx , 182xx , 451xx , 641xx , 873xx , 164xx , 186xx , 397 xx , 185xx ,

254xx

 10
U= 421xx , 332xx , 482xx , 551xx , 241xx , 373xx , 164xx , 186xx , 397 xx , 185xx ,

254xx

 11
U= 221xx , 132xx , 182xx , 351xx , 341xx , 673xx , 764xx , 186xx , 397 xx , 185xx ,

254xx

 12
U= 221xx , 132xx , 182xx , 151xx , 141xx , 373xx , 164xx , 586xx , 697 xx , 785xx ,

854xx

 13
U= 221xx , 132xx , 182xx , 551xx , 541xx , 673xx , 464xx , 186xx , 397 xx , 185xx ,

254xx

 14
U= 221xx , 132xx , 182xx , 151xx , 341xx , 573xx , 764xx , 186xx , 397 xx , 185xx ,

254xx
 15

U= 221xx , 132xx , 182xx , 151xx , 141xx , 373xx , 164xx , 086xx , 397 xx , 085xx ,

254xx

 16
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U= 221xx , 132xx , 183xx , 141xx , 151xx , 375xx , 164xx , 176xx , 353xx , 195xx ,

294xx , 163xx , 184xx

 17
U= 221xx , 432xx , 583xx , 841xx , 551xx , 375xx , 164xx , 176xx , 353xx , 195xx ,

294xx , 663xx , 184xx
 18

U= 221xx , 132xx , 583xx , 741xx , 151xx , 375xx , 164xx , 176xx , 353xx , 195xx ,

294xx , 1263xx , 484xx

 19
U= 221xx , 132xx , 183xx , 241xx , 151xx , 375xx , 764xx , 576xx , 353xx , 395xx ,

294xx , 463xx , 584xx

 20
U= 221xx , 632xx , 683xx , 141xx , 151xx , 375xx , 164xx , 176xx , 353xx , 195xx ,

294xx , 563xx , 484xx

 21
U= 221xx , 532xx , 283xx , 341xx , 451xx , 375xx , 164xx , 376xx , 353xx , 495xx ,

294xx , 463xx , 584xx

 22
U= 221xx , 332xx , 383xx , 341xx , 351xx , 375xx , 364xx , 376xx , 353xx , 395xx ,

294xx , 163xx , 384xx

 23
U= 221xx , 132xx , 583xx , 141xx , 151xx , 375xx , 164xx , 176xx , 353xx , 195xx ,

294xx , 863xx , 884xx

 24
U= 221xx , 532xx , 683xx , 441xx , 151xx , 375xx , 164xx , 776xx , 353xx , 195xx ,

294xx , 163xx , 184xx

 25
U= 221xx , 132xx , 183xx , 141xx , 751xx , 375xx , 164xx , 676xx , 353xx , 195xx ,

294xx , 863xx , 384xx

 26
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U= 221xx , 432xx , 183xx , 341xx , 151xx , 375xx , 164xx , 176xx , 353xx , 195xx ,

294xx , 163xx , 584xx

 27
U= 221xx , 482xx , 183xx , 341xx , 151xx , 375xx , 164xx , 176xx , 373xx , 195xx ,

294xx , 163xx , 584xx , 594xx

 28
U= 221xx , 132xx , 183xx , 141xx , 751xx , 375xx , 164xx , 676xx , 353xx , 195xx ,

294xx , 865xx , 384xx

 29
U= 221xx , 132xx , 183xx , 141xx , 751xx , 375xx , 164xx , 676xx , 353xx , 195xx ,

294xx , 863xx , 384xx

 30
U= 221xx , 132xx , 182xx , 151xx , 141xx , 073xx , 365xx , 186xx , 397 xx , 398xx ,

453xx

 2
    ,   -

 .
    . 39  .
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